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How do I use ISaGRAF SoftLogic and the eLogger HMI with an ISaGRAF 
WinCE-based PAC? 

Download FAQ-115 Demo 

The “eLogger” is an HMI development tool developed by ICP DAS that features an easy-to-use graphical 

user interface (GUI). The tool can be used to design both Local HMI and Web HMI pages, and allows easy 

integration with ISaGRAF SoftLogic software installed on an ISaGRAF WinCE-based PAC (e.g., WP-

8x37/8x47, WP-5147/5147-DO, VP-2xW7/4137, and XP-8x37-CE6). 

 

Users can log in to the created Web HMI pages to remotely monitor and control the ISaGRAF system 

using a standard web browser on a smart phone.  

 

 
This document and all demo programs (faq115_demo.zip) can be obtained from: 

http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq

115_demo.zip    

 

Visit the ISaGRAF FAQ web Page for more information about how to use the ISaGRAF. 

http://www.icpdas.com/en/faq/index.php?kind=280#751  
 
ISaGRAF web page: (Software/Manual) 

http://www.icpdas.com/en/product/guide+Software+Development__Tools+ISaGRAF    

 
eLogger web page: (Software/Manual) 

http://www.icpdas.com/en/product/guide+Software+eLogger+eLogger   

http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq115_demo.zip
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq115_demo.zip
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq115_demo.zip
http://www.icpdas.com/en/faq/index.php?kind=280#751
http://www.icpdas.com/en/product/guide+Software+Development__Tools+ISaGRAF
http://www.icpdas.com/en/product/guide+Software+eLogger+eLogger
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Chapter 1.  Building an ISaGRAF SoftLogic Project 

The ISaGRAF project file “eL01.zip” for the examples used in this chapter found in the “faq115_demo.zip” 

file can download from 

http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq

115_demo.zip. For users who are familiar with the ISaGRAF software, simply locate the folder where you 

stored the example files and archive these files to the PC/ ISaGRAF, and then upload the “eL01” project 

to the ISaGRAF PAC. Then, refer to Chapter 2 of this document for details of how to create HMI pages 

using eLogger. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
For those users who are not familiar with ISaGRAF, read Chapters 1 and 2 of the ISaGRAF User Manual 

for more details relating to the use of the software. The manual can download from below linkage: 

http://www.icpdas.com/en/download/show.php?num=333&nation=US&kind1=&model=&kw=isagraf  

At least one of each the ISaGRAF-256 or the ISaGRAF-32 software must be installed. Check the “Ordering 

Information” section of the ISaGRAF web page for details of how to order the software. 

http://www.icpdas.com/en/product/guide+Software+Development__Tools+ISaGRAF#443  

If the ISaGRAF software is not installed on your PC, first read Section 1.1 of the ISaGRAF User Manual for 

details of how to install it, and then read Section 1.2 of the ISaGRAF User Manual for details of how to 

install the “ICP DAS utilities for ISaGRAF” application. 

1
. 

2
. 3

. 

Note that the file name displayed as lower-case 
letters in the Archive – Projects dialog box. 

http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq115_demo.zip
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq115_demo.zip
http://www.icpdas.com/en/download/show.php?num=333&nation=US&kind1=&model=&kw=isagraf
http://www.icpdas.com/en/product/guide+Software+Development__Tools+ISaGRAF#443
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 1.1. Creating a New Project 

Launch ISaGRAF and create a new project by clicking the “New” item from the “File” menu, or pressing 

Ctrl + N. In the “Create new project” dialog box, add a name for the new project by entering “eL_01” in 

the “Name” field, then click the “OK” button to create the project. 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Double-click the name of the project to open the Programs window for the project. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Tips:  

1. To edit the comment text, select the [Set comment text] item 

from the [Edit] menu and then enter the desired text. 

2. To edit the project description, select the [Project descriptor] 

from the [Project] menu and then enter the desired description. 

2
. 

1
. 
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 1.2. Declaring the ISaGRAF Project Variables 

Before we can begin creating our project, we must first declare the required project variables. In this 

example, we will use the following ISaGRAF variables. 

 

Name Format Attributes 
Network 
Address 

Description 

Long_1 Integer Internal 1 Enables access to the 32-bit eLogger Long tag 

Word_3 Integer Internal 3 Enables access to the 16-bit eLogger Integer tag 

Word_4 Integer Internal 4 Enables access to the 16-bit eLogger Integer tag 

Float_5 Real Internal 5 Enables access to the 32-bit eLogger Float tag  

OUT_101 Boolean Output 101 
Linking to the DO0 of X304 board on the slot0 
See Section 1.5 for more details 

OUT_102 Boolean Output 102 
Linking to the DO1 of X304 board on the slot0 
See Section 1.5 for more details 

M1 Boolean Internal - 
For use with ST1 programs 
See Section 1.4 for more details 

DIR Boolean Internal - 
For use with ST1 programs that were declared with 
an initial value of “True”, see Section 1.4 

 
Click the “Dictionary” button to display the Global Integers/Reals dialog box. Once the dialog opens, click 

the “Integers/Reals” tab and double-click the “Name” field in the blank row to open the “Integer/Real 

Variable” dialog box. 
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In the Integer/Real Variable dialog box enter the name “Long_1” in the Name field, and enter a Hex value 

of “1” in the “Network Address” field. Ensure that the “Attributes” option is set to ”Internal”, and that 

the “Format” option is set to “Integer”, and then click the “Store” button to save the new variable. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Once the variable has been stored, it will show up in the “Integers/Reals” tab in the Global Integers/Reals 

dialog box. Using the same method, create the variables for "Word_3" and "Word_4" by double-clicking 

on a blank row, and then entering the relevant names and setting the Network Addresses to “3” and “4”, 

respectively. 

 

After creating these variables, the table under the “Integers/Reals” tab in the Global Integers/Reals 

dialog box should be the same as that shown in the figure below. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Using the Hex. format 
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Repeat the process described above to declare the "Float_5" variable, and set the Network Address to 

“5”. However, in this case, the “Format” option should be set to “Real”. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The table under the “Integers/Reals” tab in the Global Integers/Reals dialog box should now be the same 

as that shown in the figure below. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
Next, click the “Booleans” tab to begin creating the Boolean variables. The process for creating Boolean 

variables is the same as previously described for Integers/Real variables. Using this method, declare the 

Booleans variables OUT_101, OUT_102, and M1. Note, however, that the “Attributes” option for the 

OUT_101 and OUT_102 variables should be set to “Output”, and the “Network Addresses” for these 

should be set to “65” and “66”, respectively, (i.e., 101(10) and 102(10) ), as illustrated in the figure below.  
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For the M1 variable, the “Attributes” option should be set to “Internal”. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Once the Boolean variables created, the table found in the “Booleans” tab of the Global Booleans dialog 

box should now be the same as that shown in the figure below. 

 
 
 
 
 
 
 
 
 
 
 
 

Using the Hex. format 

65(16) = 101(10) 

66(16) = 102(10) 
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Finally, repeat the process described previously to create the "DIR" variable, and set the “Attributes” 

option to “Internal”, and check the “Set to true at init” checkbox. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
After creating all the variables, click the “Save” button to save the settings and exit the dialog.  
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 1.3. Creating an LD Program (LD1) 

In this section, we create an LD program to read the system time of the PAC, and generate a pulse "True" 

signal once every second for the M1 variable. 
 

Click the “Create new program” button to open the “New Program” dialog box and create an LD program 

named “LD1”. From the Language drop-down menu, select the “Quick LD: Ladder Diagram” option, and 

select the “Begin: Main program” option from the Style drop-down menu, as illustrated in the diagram 

below, and then click the OK button to save the new program. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

After creating the new program, a new icon for the program displays in the main “Programs” window, as 

illustrated in the figure below. Double-click the “LD1” icon to begin creating the LD program. 
 

The first thing that we need to do is add a “SYSTIM_R” function block so that we can retrieve the current 

PAC time. In the Quick LD Program window, click the “Block on the left” button to create the function 

block, or press the F6 key. 
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Double-click the newly created function block to open the Function Block dialog box. Click the 

“SYSTIM_R” option to select it, and then click the OK button to close the dialog box. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
In the Quick LD Program window, double-click the area to the right of the “SS_” parameter to open the 
Select Variable dialog box. First, select the “Integer/Real” option and click the “Word_3” option to assign 
the variable. Click the OK button to save the new variable. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Note: Select the desired option, e.g., “Integer/Real” 

to display all variables you created before. 

1
. 

2
. 

3
. 

4
. 
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Under the “SYSTIM_R” function block, repeat the process described before to add a BLINK function block 

so that we can generate a pulse that will set a Boolean variable “M1” to True once every second.  

 
As illustrated below, double-click the area to the left of the “CYCLE” parameter to open the Select 

Variable dialog box. Enter "T#1S" in the text field and then click the OK button to save the new variable. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Tip:  

Click the zoom buttons to expand or 

reduce the size of the function block. 

By default, the first option selected, i.e., 
Float_5, you should set it as a blinking 
period in seconds. 
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In the Quick LD Program window, click the coil icon to the right of the BLINK function block, as illustrated 

below, and then click the “Coil/Contact type” button several times until the “N” coil type selected.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Double-click the “N” coil icon to open the Select Variable dialog box. First, select the “Boolean” option 

and click the “M1” option to assign the variable. Click the OK button to save the new variable. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1
. 

2
. 

1
. 

2
. 

3
. 

4
. 
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The creation of the LD1 program is now been complete. Click the Save button to save the new program 

and then exit the window.  
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 1.4. Creating an ST Program (ST1) 

To begin creating an ST program, click the “New Program” button in the main “Programs” window to 

open the “New Program” dialog box and create a ST program named “ST1”. From the Language drop-

down menu, select the “ST: Structured Text” option, and select the “Begin: Main program” option from 

the Style drop-down menu, as illustrated in the diagram below, and then click the OK button to save the 

new program.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
After creating the new program, a new icon for the program displays in the main Programs window, as 
illustrated in the figure below. Double-click the “ST1” icon to begin writing the code for the ST program. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
In the ST Program window, enter the following code: 
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Once the code is completed, the ST Program window should look like the figure shown below. Click the 

Save button to save the new program and then exit the window.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

if M1 then   

  if ( Dir=True ) then    

    Word_4 := Word_4 + 1 ;    (* Counting up *) 

  else   

    Word_4 := Word_4 - 1 ;     (* Counting down *) 

  end_if ; 

end_if ; 
 

if Word_4 <= 0  then 

  Dir := True ;            (* After reaching the Min. value, change to counting up *) 

end_if ; 
 

if Word_4 >= 50  then 

  Dir := False ;            (* After reaching the Max. value, change to counting down *) 

end_if ; 
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 1.5. Connecting the I/O 

In this example, we need to install an internal XW304 expansion board (6 AI, 1 AO, 4 DI and 4 DO 

channels) in the WP-5147-OD PAC in order to control the DO0 and DO1 channels. Therefore, we need to 

add an I/O connection to the ISaGRAF program to connect to the physical I/O board in the PAC.  

 
To do this, click the "I/O connection" button in the main “Programs” window to open the I/O Connection 

dialog box, as illustrated in the diagram below, and begin creating an I/O connection. 

 
 
 
 
 
 
 
 
 
 
 

In the I/O Connection dialog box, double-click the field for "Slot 0" to open the “Select board/ 

Equipment“dialog box. Click the “Equipment” option in the “Library” section and then choose the 

“xw304” item from the list of equipment. Click the OK button to confirm your selection. The XW304 

expansion board and its respective I/O channels list in the I/O Connection dialog box. 

 

Note that you can also click the Note button for more details about the use of the XW304 expansion 

board. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1
. 

2
. 

3
. 

4
. 
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In this example, we will assign two Boolean variables named “OUT_101” and “OUT_102”, which be 

declared as the Digital Output attributes. To assign the “OUT_101” variable, click the icon for the “DO4” 

item to select it, and then double-click the icon for the channel 1 item in the right-hand side of the panel 

to open the “Connect I/O channel” dialog box. Click the “Connect” button to automatically assign the 

“OUT_101” variable to channel 1 and the “OUT_102” variable to channel 1, and then click the “Close” 

button to close the dialog box. After that, click the Save button in the I/O Connection dialog box and 

close the dialog box. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

If no reference to "xw304” is listed in the 

“Equipment” options, it means that the “ICP DAS 

Utilities for ISaGRAF” application is not installed. 

See Section 1.2 of the “ISaGRAF User's Manual" 

for details of how to install it. 

1
. 

2
. 

3
. 

4
. 

5
. 

6
. 

http://www.icpdas.com/root/product/solutions/softplc_based_on_pac/isagraf/download/isagraf-link.html
http://www.icpdas.com/root/product/solutions/softplc_based_on_pac/isagraf/download/isagraf-link.html
http://www.icpdas.com/root/product/solutions/softplc_based_on_pac/isagraf/download.html#manu
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Note:  

To set the measurement range, click the icon for “AI6” in the I/O Connection dialog and then double-click 

the “Range” item on the right hand side of the panel to open the I/O Board parameters dialog box, which 

allows you to modify the value (0 or 1). In addition, remember to adjust the jumper on the XW-board. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

0: -5 V to +5 V (-32768 to +32767) 
1: 0 V to +5 V (0 to +32767) 
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 1.6. Compiling the ISaGRAF Project 

Before compiling the project, the following compiler options MUST select.  
 

To change the compiler options, first select the “Compiler options” item from the “Make” menu to open 

the “Compiler options” dialog box. In the “Compiler options” dialog box, ensure that the “ISA86M: TIC 

code for Intel” item from the “Targets” section is selected, if not, double-click the item to select it and 

then check the checkbox for the “Use embedded SFC engine” item. In the “Optimizer” section, simply 

check the first item and click the OK button to save your changes. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Once you have completed the previous process, click the “Make application” item from the “Make” 

menu to compile the program. 

 
 
 
 
 
 
 
 
 
 
 
 

Congratulations! If no errors detected, you have 

successfully compiled the program. 

Double-click 
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 1.7. Uploading the ISaGRAF Project to the WP-5147-OD PAC 

Before uploading the project to the device, the communication parameters MUST configure. First, click 

the “Link setup” button in the main “Programs” window to open the “PC-PLC link parameters” dialog box.  
 

 

 
 
 
 
 
 
 
 
 

To upload the project via an Ethernet connection, select the “ETHERNET” option from the 

“Communication port” drop-down menu, and then click the “Setup” button to open the “ETHERNET link 

parameters” dialog box. In the “ETHERNET link parameters” dialog box, enter the IP address of the PAC in 

the “Internet address” field. Note that the Port number MUST be “502”. Click the “OK” button to save 

your changes and close the dialog box, and then click the “OK” button again to save the settings for the 

link and close the “PC-PLC link parameters” dialog box. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Next, click the “Debug” button in the main “Programs” window to open the “Debugger” panel.  

 

 

 

Debug 
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If the PAC is connected and another program is currently in use (indicated as “active” in the main 

window), click the “Stop application” button in the “Debugger” panel.to stop the active program.  

 

 

 

 

 

 

 

Click the “Download” to open the “Download” dialog box, and then ensure that the “ISA86M: TIC code 

for Intel” option is selected. Click the “Download” button to transfer the project to the PAC device.  

 
 
 
 
 
 
 
 
 
 
 
 
 
Congratulations, you have now successfully completed the process of writing, compiling, and uploading 
an ISaGRAF project.
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Chapter 2.  Designing an eLogger HMI Page 

The free and easy-to-use eLogger software from ICP DAS can be used to implement HMI and data logger 

programs that allow simple I/O monitoring and system control on ISaGRAF PACs based on Windows CE 

5.0 (e.g., the WinPAC and ViewPAC series from ICP DAS), and Windows CE 6.0 (e.g., the XPAC-8000 series 

from ICP DAS). In this case, we use the WP-5147-OD PAC. 

 
The eLogger application can develop projects quickly and easily. This requires flexible I/O configuration, a 

flexible interface, or shared memory, and can integrate with ISaGRAF programs. 

 
There are two versions of the eLogger software: eLogger Developer and eLogger Runtime. 
 

1. eLogger Developer is installed on a host PC, and is used to design HMI pages and configure graphics 

components. 
 

2. eLogger Runtime is installed on a PAC device, MUST be launched in order to process an eLogger 

project. 

 
Note: When using an XPAC or a WinPAC device, a VGA monitor must be connected the device in order 

to view the PAC/HMI screen. If an error occurs while the eLogger Runtime component is in 

operation, see Section 2.8 “Troubleshooting for eLogger Runtime operations” for details of how 

to resolve any problems.  

 
 

 2.1. Installing the eLogger software  
 

 2.1.1. Installing the eLogger Developer on the Host PC 

If the eLogger Developer software (version 1.6.2.0 or later) has never been installed on the Host PC, you 

can download the latest version at 

http://www.icpdas.com/en/product/guide+Software+eLogger+eLogger#1086   

 
After downloading the program, install it on the Host PC. For more details regarding how to install the 

eLogger Developer software, see the eLogger User Manual, which is at 

http://www.icpdas.com/en/download/index.php?nation=US&kind1=&model=&kw=elogger+  

 
 
 
 
 
Note:  

It is recommended that the Taskbar is displayed on PAC desktop because makes it more convenient 

when operating the PAC while designing the application. To do this, first connect a VGA monitor to the 

http://www.icpdas.com/en/product/guide+Software+eLogger+eLogger#1086
http://www.icpdas.com/en/download/file.php?num=2898
http://www.icpdas.com/en/download/index.php?nation=US&kind1=&model=&kw=elogger+
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VGA port on the WP-5147-OD device, and then connect a mouse to the USB port.  

Right-click the Taskbar for the device and select “Properties” from the menu to open the “Taskbar and 

Start Menu Properties” Property Sheet. In the “General” tab, make sure that the “Always on top” option 

for the Taskbar is checked, and that the “Auto hide” option is unchecked. Click te “OK” button to save 

the settings. 

 
 
 
 
 
 
 
 
 
 
 

 2.1.2. Installing the eLogger Runtime on the PAC 

If the eLogger Runtime environment (version 1.6.2.0 or later) has never been installed on the PAC, the 

relevant installation files can be found in the installation folder for the eLogger Developer, which can be 

found at C:\ICPDAS\eLogger eLogger_Runtime\For_WinPAC if the eLogger Developer was installed in the 

default location.  

 

To begin installing the eLogger Runtime, first, double-click the “My Device” icon on the PAC desktop and 

then open the \System_Disk directory. Select the “New Folder” item from the “File” menu and create a 

new folder called “eLogger”. 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Right-click 

\System_Disk 

2
. 

1
. 

3
. 

4
. 
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Note that before attempting to install the eLogger Runtime via FTP, you should open the WinPAC Utility 

and ensure that the FTP function enabled and the download directory is set to “\” in the Network 

Settings tab. If this is not the case, change the settings where necessary and then click the “Set” button 

to save the changes. Click the “Save and Reboot” item in the “File” menu to save the settings and restart 

the PAC. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

In this example, the eLogger Runtime installed on a WP-5147-OD PAC. To install the eLogger Runtime, 

copy all the files contains in the C:\ICPDAS\eLogger\eLogger_Runtime\For_WinPAC folder on the Host 

PC to the newly created \System_Disk\eLogger folder on the PAC via FTP (e.g., 

ftp://192.168.79.23/System_Disk/eLogger/). 

 

 
 
 

 
 

1
. 2

. 

3
. 

4
. 
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Next, copy the “SharedMemory.dll” file that is found in the \System_Disk\eLogger\ 

copy_to_system_disk\icpdas\system folder on the PAC to the \System_Disk\ICPDAS\System folder. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Select the “New Folder” item from the “File” menu and create a new folder called “webpages” in the 

\System_Disk\eLogger\. Then, copy the “base” and the “WebBase” folders that found in the 

“copy_to_www_root” folder to the webpages “webpages” folder. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Note: When uploading the project that contains web pages, the “webpages” folder 

automatically creates in the same folder where “RuntimeCE.exe” is located, 

e.g., \System_Disk\eLogger\. But you still need to copy the “base” and the 

“WebBase” folders to the “webpages” folder manually. 
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 2.2. Creating an eLogger Project 

ICP DAS provides an example project named “eL_01.wez” that can be used for reference. The files for 

this project can obtain from 

http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq

115_demo.zip . 

Unzip the demo file and copy the files eL_01.wez to eL_06.wez to the C:\ICPDAS\eLogger\ 

eLogger_Developer\Project\ folder on the Host PC. Launch the eLogger Developer software, and then 

click the “Open” item in the “Project” menu to open an existing project. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Alternatively, to create a new project, click the “New” item in the “Project” menu and give the new 
project the name “eL_01”. Note that you should avoid giving this project the existing name “Demo”. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

By default, there is a file called Demo.wez 
in this folder, so DO NOT name it “Demo”. 

http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq115_demo.zip
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq115_demo.zip
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It is recommend that you set the eLogger Sampling Time to 1 second. To do this, enter 1 in the Samping 
Time (sec) field. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Note that you CAN NOT enable the Driver, or add the Device and Register, when operating the eLogger 

HMI and ISaGRAF SoftLogic on the same PAC. 

 
 

 2.3. Declaring the eLogger Tag 

Tags used in eLogger in order to share data with ISaGRAF variables. However, only AO and DO tags can 

choose. Note that eLogger AI and DI tags cannot use to share data with ISaGRAF variables. 
 

AO tags can be used to share eLogger data with Integer, REAL, Timer, AI, and AO variables in ISaGRAF, 

while DO tags can share eLogger data with Boolean, DI, and DO variables in ISaGRAF. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
In the navigation pane, expand the “Tag Mapping” section and click the “AO Tag” item to display the 

specific configuration screen, and then click the “New Tag” button, as illustrated in the figure above. 

1
. 2

. 
3
. 
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In this example, we need to use four AO tags. In the “Add Tag” dialog box, enter “4” in the “How many 
tags to add?” field and then click the “OK” button to add four data rows. The following table list the 
address and the data type for all tags that we will create later.  
 

Tag Name Address Data Type 

Long_1 1 32-bit Signed Long 

Word_3 3 16-bit Signed Integer 

Word_4 4 16-bit Signed Integer 

Float_5 5 32-bit Float 

 
In the configuration screen of the AO Tag, select the first row of data and enter the name “Long_1” in the 

Tag Name field, set the Memory Address to “1”, select the “32-bit Signed Long” option from the Data 

Type drop-down menu. By default, the Gain is “1”, and the Offset is “0”, as illustrated in the figure below. 
 

 

 

 

 

 

 

 

 
 

 
However, according to the definition for ISaGRAF data types, a 32-bit Integer or a REAL must occupy two 

Modbus addresses. In this example, the address for the “Long_1” tag is set to 1, so the address number 2 

cannot be assigned to other tags. 

 

After entering all the relevant information for the first tag, repeat the process to create AO tags 2 to 4 

using the information illustrated in the figure below.  
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Note: The name of the eLogger tag can be different to that of the ISaGRAF variable because they share 

data with each other by using the memory address (called the Network Address in ISaGRAF) 

rather than the individual names.  

 
In this example, we also need to add two DO tags. This achieve in a similar manner as the process for 

adding the AO tags. In the navigation pane, expand the “Tag Mapping” section and click the “DO Tag” 

item. The following table list the address of DO tags that we will create later. 

 
 

Tag Name Address 

DO_101 0 

DO_102 1 

 
 
 
Add two new DO tags by following the process described for the AO tags above. Once complete,  
the screen should be the same as that illustrated below. 
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 2.4. Creating and editing an eLogger Page 

When the eLogger Runtime (RuntimeCE.exe) activate on the PAC, the name “Page0” initially displayed. 

Note that this can rename to a preferred name if necessary at any time.  
 

In this example, we will use two pages called Page0 and Page1 to create our HMI interface. To add a new 

page, Page1 in this case, click the “Page” item in the navigation pane to select it, and then click the 

“New” button to create the new page. The name “Page1” will display in the navigation pane. Note that 

this new page can rename at any time, or you can choose not to change it if desired.  

 
 
 
 
 
 
 
 
 

 
 
 
 
 

Expand the “Page” label in the navigation pane and click the “Page 1” item to display the new page. 

Select the desired VGA resolution for the ISaGRAF PAC from the Layout Size drop-down menu to set all 

pages as the same resolution. 

 
 
 
 
 
 
 
 
 
 
The following is an overview of the maximum VGA resolution that can select for the various ISaGRAF PAC 

models: 
 

Model Resolution 

XP-8x37-CE6 and WP-8x37 1024 x 768 

WP-8x47, WP-5147/5147-OD and VP-4137 (with TouchPad) 800 x 600 

VP-25W7 (with TouchPad) 640 x 480 

VP-23W7 320 x 240 

1
. 

2
. 

3
. 

1
. 2

. 

3
. 
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 2.4.1. Add a Label Component  
 

The first thing we need to do is give the page a title. We do this by adding a Label component. From the 

toolbar in the Project window, click the “Label” item and click on the screen to add a Label component to 

Page1. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Place the Label component in the desired position on the screen and drag the handles to resize it to a 

suitable size. The attributes for the component, such as the display text, the font size, and the color, can 

configure in the property window, as illustrated in the diagram below. 

 
 
 
 
 
 
 
 
 
 
 
 
Note: You can click the component to display the property window for the component. In addition, you 

can also right-click on a component to cut, copy, paste or delete it. 

 
 
 
 
 

Right-click 
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 2.4.2. Add a SwitchPage Component 
 

To allow us to navigate between different pages, we need to add a “SwitchPage” button. We do this by 

adding a Button component. From the toolbar in the project window, click the “Button” item and click on 

the screen to add a Button component to Page1. 

 
 
 
 
 
 
 
 
 

Place the Button component in the desired position on the screen and drag the handles to resize it to a 

suitable size. Select the “SwitchPage” option from the “Button Type” drop-down menu, and select 

“Page0” from the “Switch Page to” drop-down menu. Configure the desired attributes for the 

component in the property window, such as the display text, the font size, and the color, as illustrated in 

the diagram below. 

 
 
 
 
 
 
 
 
 
 
 
We now need to add Label and SwitchPage Button components to Page0. To do this, first expand the 

“Page” label in the navigation pane and click the “Page0” item to display the page. Next, follow the same 

process described above to add a Label component and a SwitchPage Button component to Page1, and 

then adjust the attribute settings so that they are the same as those illustrated in the figure below. 
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 2.4.3. Add an LED Component  
 

We need to add a component that will allow us to turn the lamp on and off via a DO variable OUT_101, 
and its corresponding eLogger DO tag, DO_101. This can achieve by adding an LED component. From the 
toolbar in the project window, click the “LED” item and click on the screen to add an LED component to 
Page0. 
 
 
 
 
 
 
 
 
 
 

Place the LED component in the desired position on the screen and drag the handles to resize it to a 

suitable size. Select the “DO Tag” option from the “Tag Type” drop-down menu, and select “DO_101” 

from the “Tag Name” options. In the “Display Format” section of the property window. Ensure that the 

“ConfirmWindow” option is set to “True”, which specifies that tag data can be output after user 

confirmation. 

 

Next, set the “MouseControl” option to “True”. This means that data can be allow to write. If this 

attribute is set to "False", it means that data can be only to read. Then, configure the desired attributes 

for the component, such as the text style and color, etc., as illustrated in the diagram below. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Note the Tag Desciption field is automatically 
assigned according to the Desciption field on the 
DO Tag screen, and cannot be changed here. 
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 2.4.4. Add a Switch Component  
 

We also need to add a component that will allow us to turn the switch on and off via a DO variable. This 
can achieve by adding a Switch component. From the toolbar in the project window, click the “Switch” 
item and click on the screen to add a Switch component to Page0.  
 
 
 
 
 
 
 
 
 
 

Place the Switch component in the desired position on the screen and drag the handles to resize it to a 

suitable size. Select the “DO Tag” option from the “Tag Type” drop-down menu, and select “DO_102” 

from the “Tag Name” options. Ensure that the “ConfirmWindow” option is set to “True” which specifies 

that tag data can be output after user confirmation.  
 

Next, set the “MouseControl” option to “True”. This means that data can be allow to write. If this 

attribute is set to “False”, it means that data can only be to read. Then, configure the desired attributes 

for the component, such as the text style and color for the ON and OFF states, etc., as illustrated in the 

diagram below. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Optionally, you can add two additional Label components to 

describe the purpose of the LED and Switch components.  

 

Note the Tag Desciption field is automatically 
assigned according to the Desciption field on the 
DO Tag screen, and cannot be changed here. 
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 2.4.5. Add a Seven Segment Component 
 

So that we can monitor the AO values, we need to add a 7-segment numerical component. From the 
toolbar in the project window, click the “Seven Segment” item and click on the screen to add a 7-
segment numerical component to Page0. 
 
 
 
 
 
 
 
 
 
Place the 7-segment numerical component in the desired position on the screen and drag the handles to 

resize it to a suitable size. Select the “AO Tag” option from the “Tag Type” drop-down menu, and select 

“Long_1” from the “Tag Name” options. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Set the “MouseControl” option to “True”, which means that write data is allowed. If this attribute is set 
to “False”, it means that data can only be to read.  
 
In this example, the data type for the “Long_1” tag is a 32-bit Long, so no decimal places are required. 

Set the “Decimal” to “0” and the “DigitalNumber” to “10”. Note that the “DigitalNumber” attribute can 

be set in the range of 1 to 24. 
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In certain situations, the on-site staff may be required to enter a value within a specified range. To 

implement this functionality, set the required “OutputLimit (Min.)” and “OutputLimit (Max.)” values in 

the respective fields. Optionally, you can add a Label component to describe the purpose of this 

component. 
 

Configure the desired attributes for the component, such as the text style and color, etc., as illustrated in 

the diagram above. After creating the first 7-segment component, repeat the process to add two further 

“Seven Segment” components, and configure them using the information illustrated in the figure below. 

Again, add two more Label components that describe their usage. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Note: You can click the component 
to display the property window for 
the component. In addition, you can 
also right-click on a component to 
cut, copy, paste or delete it. 
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 2.4.6. Add an Angular Gauge Component 
 

It would be helpful to add a component that will allow us to monitor the AO values of a gauge. This can 

achieve by adding an Angular Gauge component. From the toolbar in the project window, click the 

“Angular Gauge” item and click on the screen to add an angular gauge component to Page0. 

 
 
 
 
 
 
 
 
 
 

Place the Angular Gauge component in the desired position on the screen and drag the handles to resize 

it to a suitable size. Select the “AO Tag” option from the “Tag Type” drop-down menu, select “Word_4” 

from the “Tag Name” options, and set the “MouseControl” option to “False”, meaning that data can only 

be read.  
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In the “Display Options” section of the property window, set the “ScaleMin” option to “0”, and the 

“ScaleMax” to “50”. In this example, this output value will be defined in the ISaGRAF program as being in 

a range from 0 to 50.  

 

Note: You can click the component to display the property window for the component. In addition, you 

can also right-click on a component to cut, copy, paste or delete it. 

 

 

 

 

 

 

 

 

 

 

 

Next, set the “GaugeAngleMin” value to 150, which signifies that the minimum value is located at 150 

degrees in the anti-clockwise direction, where zero is the baseline of the Angular Gauge component. Set 

the “GaugeAngleSpan” value to 120, which signifies that the range that the pointer can travel is 120 

degrees. For example, 

 

 

 

 

 

 

 

 

 

 

 

You can specify the color that different sections of the range will be displayed in, e.g., green, yellow and 

red, which allows you to quickly check the status. In this example, we will set the 

“ColorSectionGreenStart” value to “0”, the “ColorSectionGreenStop” value to “20”, the 

“ColorYellowSectionStart” value to “20”, and the “ColorYellowSectionStop” value to “40”, as illustrated in 

the diagram below.  

 

Finally, we will add a Label component to identify this component. 

Label 

GaugeAngleMin = 90 
GaugeAngleSpan = 180 

GaugeAngleMin = 180 
GaugeAngleSpan = 180 0 

90 

180 

270 
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 2.5. Save or Backup the eLogger Project 

Congratulations! If you have closely followed the instructions above, you should have successfully 

created your first eLogger project, which should look similar to that illustrated in the diagrams below. 
 

Page0: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Page1: 

 
 
 
 
 
 
 
 
The next step is to create a backup of the Project file, which will have a .wez file extension. By default, 

eLogger will automatically save the project file in the C:\ ICPDAS\eLogger \eLogger_Developer \Project 

folder. 

 
 
 
 
 
 
 
 

Note:  

After completing an eLogger project, we recommended that 

you create a backup of the project file (.wez). By default, the file 

will be stored in the C:\ ICPDAS\eLogger \eLogger_Developer 

\Project folder. You can also save the backup file in your 

preferred folder, for example C:\........\Project\backup. 
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 2.6. Uploading the eLogger Project 

In this example, we will use a WP-5147-OD PAC that has an XW304 expansion board connected, in 

combination with the ISaGRAF and eLogger HMI software. You need to upload the ISaGRAF project to the 

WP-5147-OD PAC (see Section 1.7 “Uploading the ISaGRAF Project to the WP-5147-OD device” for details 

of how to do this). 
 

Next, verify that the eLogger Runtime have been installed on the PAC (see Section 2.1.2 “Installing the 

eLogger Runtime component on the PAC” for more details). Before uploading the eLogger project to the 

PAC, first double-click the “My Device” icon on the PAC desktop, and then launch the “RuntimeCE.exe” 

application from the \System_Disk\eLogger folder. 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Next, select the “Remote Machine” option from the “Project” menu in the eLogger Developer on the 

Host PC and enter the IP address of the PAC in the RemoteMachine dialog box. Click the “Upload Project 

& Web Pages” button to upload the project to the WP-5147-OD PAC. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Note: If the eLogger Runtime application have not activated, a dialog box with 
an error message will display.  

1
. 

2
. 
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If the project file was successful uploaded, 

the name of the project (eL01.wez in this 

case) will be displayed in the eLogger 

Runtime application.  

 

Once the project is uploading, check the 

checkbox for the “Auto Run” option 

automatically to execute the project 

whenever the "eLogger Runtime" 

application is activating.  

 
 
 

To launch the “eLogger Runtime” application each time the PAC powers on, you need to set the “Auto 

Execution” options, as illustrated in the diagram below. To do this, launch the WinPAC Utility on the PAC 

and click the “Auto Execution” tab. Click the “Browse” button for the “Program 2” entry and select the 

“\System_Disk \eLogger\RuntimeCE.exe” file.  
 

By default, the first program listed in the “Auto Execution” tab (i.e., Program 1) must be the ISaGRAF 

driver for each PAC, which is isaWP5xx7.exe in this case. Click the “Set” button to save the changes, and 

then click “Save and Reboot” in the “File” menu. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1
. 

2
. 

3
. 

4
. 

5
. 
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 2.7. Testing the eLogger HMI  

Once the PAC is activating, the eLogger HMI screen that we created in our example above will display, as 

illustrated the figure below. Click any of components to test that they function correctly, and set the 

ISaGRAF software to connect to the PAC (see Section 1.7 for more details), to verify that the data is 

correct.  

 

For example: 
 

1. Click the “Float_5” component, enter the value “5.5” and then click the OK button. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. Verify that the value of the “Float_5” variable in the ISaGRAF application has changed to “5.5”. 
 
 
 
 
 
 
 
 
 
 
 
 
Note: These values will only display when the ISaGRAF project executes. 
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The eLogger HMI perform in a full screen on the PAC by default, so you cannot do any operations. When 

you want to upload a modified project, click the “Remote Machine” option in the “Project” menu in the 

eLogger Developer application on the Host PC to open the “RemoteMachine” dialog box, and then click 

the “Stop” button to terminate the project that is currently operating. Click the “Run” button to restart 

the project. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 2.8. Troubleshooting eLogger Runtime operations 
 

If you are still unable to close the eLogger HMI page when it 

displays as full-screen using the method described above, you 

can remove the “ICPDAS_eLogger.xml” file in Safe mode.  

 

To do this, set the Rotary Switch on the PAC panel to position 

“1” and then reboot the PAC. Once the PAC restarts, the 

ISaGRAF and eLogger applications will not automatically 

activate, thereby allowing other operations to be performing 

on the PAC.  

 

First, double-click the “My Device” icon on the PAC desktop. 

Next, either delete or rename the “ICPDAS_eLogger.xml” file 

that is located in the \System_Disk\eLogger\ folder, and then 

set the Rotary Switch to “0”, and then reboot the PAC.  

 

When the eLogger Runtime activated automatically, you can 

upload the modified project again. 

 

Note: Remember to check the checkbox for the “Auto-Run” option in the eLogger Runtime application.  

Run the project Upload the project 
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 2.9.  Other Advanced eLogger Functions 

There are a number of other more advanced functions available in the eLogger application, which will be 
described in more detail below. 

 

 2.9.1. Setting the Gain and Offset for Scaling Data  

For many applications, the data values displayed in engineering format rather than in integer format. 

 

For instance, when the “Range” value for the XW304 expansion board (6 AI, 1 AO, 4 DI, 4 DO) is set to 

“0”, it means the module is used to measure voltages in a range from -5 to +5 V. See Section 1.5 

Connecting the I/O for more details about the use of the XW304 expansion board. 
 

In the ISaGRAF application, the measured value for the “Range” variable is a signed 16-bit integer that 

has a range from -32768 to +32767. In order to display the range -5 to +5 on the eLogger HMI page, the 

Gain and the Offset values have to be set. 
 

Note: If the Gain set to “1” and the Offset set to “0”, it means that no data conversion will perform. 
 
In this case, the “AI_7” variable use to read a value from any channel of the XW304 module. Note that 

the data type for this variable is set as a “16-bit Signed Integer”. 

 
 
 
 
 
 
 
 
 
 
 
Note: Only eLogger AO and DO tags can be to share data with ISaGRAF variables. AO tags can be to 

share eLogger data with Integer, REAL, Timer, AI and AO variables in ISaGRAF. 

 

 

In the navigation pane, expand the “Tag Mapping” section, and click the “AO Tag” item and click the 

“AI_7” tag to select it, as illustrated in the figure above. In the “AO Tag” screen, click the “Scaling” button 

to open the “Scaling” dialog box. Select a channel type from the “Channel Type” drop-down menu (e.g.,  

-5 to +5 V), and then click the “OK” button to save the selection. When you return to the “AO Tag” screen, 

the Gain and Offset values have entered in the respective fields. 

 

 

http://www.icpdas.com/root/product/solutions/pac/upac/xw304.html
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Testing the Data Conversion functionality:  

First, add a “Seven Segment” component to any page and configure the attributes as follows. 
 

Set the Tag Type to “AO Tag”, the Tag Name to 

“AI_7”, and the “MouseControl” option to “False”, 

the “Decimal” item to “1”, and the 

“DigitalNumber” item to “3”. 

 
Also, add the “AI_7” variable to the ISaGRAF 

project, set the “Attrib.” property to “internal, 

integer”, and set the “Addr.” Value to “7”. 

 
After configuring the above settings, upload both 

the ISaGRAF and the eLogger projects to the PAC. 
 

In the ISaGRAF project, set the value for the 

“AI_7” variable to “32767”, which means that the 

converted value (AI_7 = 5.0) will be displayed on 

the eLogger screen on the PAC.  

 
 

 
 
 
 
 
 
 
 
 

PC – ISaGRAF project 
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 2.9.2. Declaring multiple eLogger Tags that have a similar Name or are of the same Type 
 

The eLogger application allows you to add multiple tags and declare them with a similar name or the 

same data type.  
 

As an example, expand the “Tag Mapping” section in the navigation pane and click the “AO Tag” item. In 

the “AO Tag” screen, click the “New Tag” button to open the “Add Tag” dialog box and add ten new AO 

tags, as illustrated in the figure below. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

You can simultaneously edit the details of multiple tags by first selecting the first data row then holding 

the Shift key and clicking the last row to select all of the rows. You are then able to assign any of the data 

types (e.g., 32-bit Float) to all of the tags at the same time.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1. 

2. 

3. 
Click the first row, and then click the 

last row while holding the “Shift” key. 
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You can also use the same approach to give a similar name or description to a range of tags by selecting 

them and entering the desired name in the “Tag Name” field, or by entering the desired description in 

the “Description” field. 
 

Note that the numeric value in the “Tag Name” or the “Description” field generated based on the 

position of the tag in the list. 
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 2.9.3. Switching eLogger HMI Pages via the ISaGRAF Program 
 

Creating the functionality that allows the user to navigate between HMI pages via the ISaGRAF program 

is easy to implement and will be described in detail below.  

 

The ISaGRAF Settings: 

Declare two ISaGRAF variables, as described in the table below: 
 

Name Format Attributes 
Network 
Address 

Description 

To_Page Integer Internal 
8191 

(Hex = 1FFF) 

This variable is used to switch between 

the eLogger HMI pages 

Set the initial value to 65535 

Current_Page Integer Internal 
8190 

(Hex = 1FFE) 
This variable is used to read the current 
page number 

 

Note: This function is only supported in eLogger Runtime version 1.2.1.0 or later. 
 
If the Network address of an integer variable, e.g., the “To_Page” variable, is set to “8191” (Hex = 1FFF), 

it means that the variable value is used to switch to the specified page number. For example, if the 

“To_Page” variable is set to 5, the eLogger HMI will switch to Page 5, and then the value will be reset to 

65535. However, if the “To_Page” variable set to a non-existent page number, the eLogger HMI will not 

switch to that page. 
 

If the Network address of an integer variable, e.g., the “Current_Page” variable, is set to “8190” (Hex = 

1FFE), it means that the eLogger HMI will automatically update the variable value to that of the current 

page number. This value can be 0, 1, or 2, and so on. 
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The eLogger Settings: 

We need to declare two AO tags called “To_Page” and “Current_Page”. To do this, expand the “Tag 

Mapping” section in the navigation pane and click the “AO Tag” item. In the “AO Tag” screen, click the 

“New Tag” button to open the “Add Tag” dialog box and add two new AO tags, as illustrated in the figure 

below. For more information related to eLogger tags, refer to Section 2.3 "Declaring the eLogger Tag". 

 
 
 
 
 
 
 
 
 
 
 
 

Now add several additional pages and then configure them so they are similar to that shown in the figure 
below. Refer to Section 2.4 "Creating and editing an eLogger Page".  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Finally, upload the ISaGRAF and eLogger projects to the PAC. See Section 1.7 and 2.6. To test that the 

project is functioning correctly, double-click the component (“To_Page”) to set a value on the HMI screen 

to verify that the HMI page switched to the specified page, and to verify that the current page number is 

in the “Current_Page” variable.  
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Chapter 3.  Example Programs for eLogger and ISaGRAF  
 

 3.1. Downloading the eLogger and ISaGRAF Projects described in the this document 
 

ICP DAS provides a zip file named “faq115_demo.zip” that contains all the projects described within this 

FAQ document. This file can be download from 

http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq

115_demo.zip   

 

 3.1.1. Open an eLogger Project 
 

To open an existing eLogger project, unzip the download file and copy all the .wez files, i.e., eL_01.wez to 

eL_06.wez, to the C:\ICPDAS\eLogger\eLogger_Developer\Project\ folder on the Host PC, or any 

location you installed the eLogger HMI. Launch the eLogger Developer application, and then click the 

“Open” item in the "Project” menu to open the file.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq115_demo.zip
http://www.icpdas.com/web/product/download/software/development_tool/isagraf/document/faq/faq115_demo.zip


Classification ISaGRAF English FAQ-115 Author Chun 

Editor Janice Hong Version 1.0.5 Date 2017/12 Page 51 / 82 

 

 

ICP DAS Co., Ltd. Technical Document 

 3.1.2. Open an ISaGRAF Project 

To open an existing ISaGRAF project, unzip the download file and copy all .pia files, i.e., eL_01.pia to 

eL_06.pia, to any location on the Host PC, e.g., D:\TEMP\. Launch the ISaGRAF software and click the 

“Projects” item in the “Archive” option of the “Tools” menu to open the “Projects” dialog box.  
 

Click the “Browse” button to locate files and click the desired project name(s) in the Archive panel of the 

Projects dialog to select them, and then click the “Restore” button to restore the project(s). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

In the ISaGRAF Project Management window, double-click the name of the project to open the project.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1 

3 

2 

4 
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 3.2. How to use the eLogger Web HMI 

The eLogger Developer software allows you to design web-based HMI pages, set the username and 

password for the login web page, or import or export an existing web page. After downloading the 

eLogger project to the PAC, you can log into the web-based HMI page via a regular web browser, such as 

Google Chrome, Internet Explorer, Firefox, Safari, or Opera, etc., allowing you to control the device 

remotely. 
 

In this example, we will use the following project files: 

ISaGRAF Project File:  eL_01.pia   

eLogger Project File:   eL_01.wez, eL_01.wp 
 

We will create two web pages called login (the default page) and index1. To add a new page, click the 

Web Page item in the navigation panel and then click the “New” button to create a new page.  

Alternatively, you can create a new page with a specific name by entering the name in the text field and 

clicking the “New” button. 
 

If desired, enter a name for the page by clicking the “Rename” button and entering the preferred name.  

This dialog also allows you to create a login username and password if required, as well as import or 

export specific web pages, refer to the eLogger user manual for more details by clicking the “Help” 

button.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

You can enter a name for 
the page here and then 
click the New button. 
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 3.2.1. Editing the Login Web Page 

The eLogger Developer software provides a login web page by default, however, you CAN NOT add or 

remove any components to or from this page, although you are able to modify them where necessary. 

In addition, you can set the background color by clicking on the page and choosing a desired color from 

the color options, or add a background image to the web page by clicking the “Background Picture” 

option from the menu.  

Note that the background image will be upload to the “WebBackPic” folder that is located in the root 

HTTP directory on the PAC. See Section 2.1.2 to verify the HTTP path in the Network Settings tab of the 

PAC Utility. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The Login web page contains two label components, two textbox components, and a button component. 

To configure an individual component, click the component to display the related attribute window and 

then modify the properties where necessary. 

 
 

 
 
 
 
 
 

 

 

 

 

 

1 

3 

 

The “True” option in the Password 
attribute indicates that the text 
entered in the field will display in 
password format. 

2 

1 2 

3 
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 3.2.2. Designing an eLogger Web Page 

In Section 2.4, we described how to design a local HMI page. The following is a description of how to 

create a Web–based HMI page, together with details of how to remote control the components on the 

page via a standard web browser.  

 
First, add a background image to the web page by clicking the “Background Picture” option from the 

menu. Note that the background image will be stored in the “WebBackPic” folder that is located in the 

root HTTP directory. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
The following is a description of all the components that used 
on the eLogger web page - index1. 
 
1) Label: 

There are three Label components on this web page (i.e., 

DO_101, DO_102, and Long1), which are used to describe 

the purpose of the components. 

 
 
 

1 

2 

3 

4 

Label Button 

Picture Toggle 
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2) Picture Toggle: 

Two Picture Toggle components are used to display or control the state of the DO tags (i.e., DO_101 

and DO_102). Configure these components as illustrated in the figure below. 

 

MouseControl: When this attribute is set to “True”, it means that the component can read/write 

data to/from the DO tag.  

When set to “False”, it means that data can only read. 

Off/OnPicture: This attribute used to select the image to display when the state of the DO tag is set 

to OFF or ON. Note that the default images are stored in the 

C:\ICPDAS\eLogger\eLogger_Developer\WebPic folder. 

ValueTest: Set this attribute to “True” to view the ON image; set it to “False” to view the OFF 

image. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

These images will 

also be stored in the 

\HTTP root\WebPic 

folder on the PAC. 
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3) Seven Segment: 

The page contains a single Seven Segment component 

that is used to display or write the value of the AO tag 

(i.e., Long_1).  

 
 
 
 
 
 
 

Configure this component as illustrated in the figure: 

Output Limit (Min/Max):  

These attributes used to specify the maximum and 

minimum values for the output range. Set these values 

to -32768 and 32767, respectively. 

Decimal:  

This attribute used to determine the number of 

decimal places to use. Set this value to “0”. 

DigitalNumber:  

This attribute used to specify the number of digits to display. Set this value to “10”. 

MouseControl: 

When this attribute is set to “True”, indicates that the component can read/write the value 

to/from the AO tag. 

 
4) Button: 

The page contains a single Button component to allow 

users to log out from the page. 
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 3.2.3. Testing the eLogger Web HMI 

Before testing the web page, make sure that you have uploaded both the ISaGRAF project (eL_01.pia, see 

Section 1.7 “Uploading the ISaGRAF Project”) and the eLogger project (eL_01.wez, see Section 2.6 

“Uploading the eLogger Project”) to the PAC. In addition, the web folders install, see Section 2.1.2. 
 

1. Open a web browser on the Host PC and enter the IP address of the PAC (e.g., 192.168.79.23) in the 

address bar. When requested, enter the username and password (default is admin/0000) and click the 

Log in button to log into the web page. 

 
 
 
 
 
 
 
 
 
 
 
 

2. Click the Picture Toggle component to set the state of the DO tag to ON or OFF. Also, click the Seven 

Segment component to enter a value in the “Value Entry” dialog box, and click the “Set” button to 

change the value of the AO tag. 
 

3. Click the LogOut button to log out the web page. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Note: Before testing the HMI using a negative value, you must first assign a negative value to the 

Long_1 variable on the local HMI page to avoid an error occurring on the digit display. 

Picture Toggle 

Seven Segment 
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 3.3. Configuring a Control Button that can be instantly turned ON and then OFF 

In this example, we will use the following project files: 

The ISaGRAF Project File:  eL_02. pia   

The eLogger Project File:  eL_02.wez 
 

In this example, when you click the Switch component and set it to ON, the ISaGRAF program will send a 

message that contains the current date and time on the PAC via the COM1 (RS-232) port on the WP-

5147-OD. The HyperTerminal utility may launch on the Host PC or be downloaded from the web. In the 

utility, open an RS-232 port (9600, 8, N, 1) to receive this message. In addition, the state of the “Switch” 

on the eLogger screen will automatically reset to OFF by the ISaGRAF program. 

 

 3.3.1. The Developer Settings in eLogger 

Add a new DO tag by expanding the “Tag Mapping” section in the navigation pane and then clicking the 

“DO Tag” item. In the “DO Tag” screen, click the “New Tag” button to add the new tag. Enter the name 

“Switch1” and set the memory address to 1. For more information related to eLogger tags, refer to 

Section 2.3 "Declaring the eLogger Tag". 

 
 
 
 
 
 
 
 
 
 
 
Expand the “Page” item in the navigation pane, and click the entry for “Page0”. Add a “Switch” 
component to Page0 and configure it using the values illustrated in the figure below. 
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 3.3.2. The ISaGRAF Settings 

Before we can begin creating our project, we must first declare the required project variables. See 

Section 1.2 Declaring the ISaGRAF Project Variables if you are not familiar with this example, we will use 

the following ISaGRAF variables. 
 

Name Format Attributes 
Network 
Address 

Description 

Switch1 Boolean Internal 1 
This variable is used to access the 
eLogger Switch 

TMP Boolean Internal 0 
This variable is used to check the COM 
port is sucessfully be opened 
TRUE: OK  ;  FALSE: Failured 

INIT Boolean Internal 0 
Set the Init. value to TRUE and then set 
it to FALSE to do the COMOPEN() 
function once at the first scan cycle 

STR1 Message Internal 0 
This variable is used to save the date 
and time in a string format. Set the 
maximum length of the STR1 to 64 

Year1 Integer Internal 0 

These variables are used to read the 
current date and time on the PAC 

Month1 Integer Internal 0 

Day1 Integer Internal 0 

WeekDay1 Integer Internal 0 

Hour1 Integer Internal 0 

Minute1 Integer Internal 0 

Second1 Integer Internal 0 

 

You can declare or view variables in the variable declaration window by clicking the “Dictionary” button. 
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Program - ST1: 
When the Switch component is set to TRUE on the eLogger HMI, the program will send a message that 
contains the current date and time on the PAC via the COM1 port. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Program - LD1: 
Using the SYSDAT_R and SYSTIM_R functions to read the system date and time of the PAC. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(* Open COM1 using the default values 9600,8,N,1. In the first scan cycle, "INIT" must declar with an 

initial value of True *) 
 

if  INIT  then 

   INIT := False ;   (* This only needs to be done once during the first scan cycle *) 

   TMP := COMOPEN( 1 , 9600 , 8 , 0 , 1 ) ; 

end_if ; 
 

(* If "Switch1" is set to be True in eLogger, send a message to COM1 *) 

if  switch1  then 
 

  (* Convert the date and time to a string, such as 'Jun/08/2017,13:25:45' *) 

  str1 := time_str( year1 , month1 , day1 , weekday1 , hour1 , minute1 , second1 ) ; 

  str1 := str1 + MSG('$0D$0A') ;  (* Add <CR><LF> to the end of the string *) 
 

  (* Send the message to COM1 *) 

  TMP := COMSTR_W( 1 , str1 ) ; 
 

  switch1 := False ;  (* Reset Switch1 when finished *) 
 

end_if ; 
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 3.3.3. Testing the “eL_02” Project 
 

Connect an RS-232 cable from the COM1 port on the WP-5147-OD to an RS-232 port on the Host PC. 

Power on the PAC and launch the HyperTerminal utility to open the RS-232 port using the default values 

of “9600, 8, N, 1”. Note that the HyperTerminal does not exist on Windows after Windows 7 so you can 

also download it or other software such as PuTTY or PieTTY or Tera Term on the web. 

 
PAC - eLogger HMI screen: 

To send a message via the COM1 port, first click the “Send_it” button on the eLogger HMI screen. In the 

“DO” dialog box, click the “ON” radio button and then click the OK button. 

 
 
 
 
 
 
 
 
 
 
 
 
 

PC – HyperTerminal (9600, 8, N, 1): 

Then, you can see the system time of the PAC is display on the HyperTerminal screen. 

 
 
 
 
 
 
 
 
 
 
 
 
Note: After uploading a modified ISaGRAF project to the PAC, you should execute the Remote Machine 

function in the eLogger Developer application to terminate the eLogger project and then launch 

the project again. See Section 2.6 “Uploading the eLogger Project” for more details.  
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 3.4. Reading/Saving the Process Parameters from/to a File (Data Format: REAL) 
 

In this example, we will use the following project files: 

 

The ISaGRAF Project File:  eL_03. pia   

The eLogger Project File:  eL_03.wez 
 
This example provides 20 process parameters that enter into the eLogger HMI screen for the WP-5147-

OD. These values will be stored in the Working_Real.txt file that saved in the \System_Disk\ folder. 

Note that you should ensure this file is using ANSI encoding. The Working_Real.txt file contains two rows, 

and each row contains ten REAL values, as illustrated below: 
 

23, 65.9, 0.12, 5.87, 88.2, 0.34, 8.5, -2.08, 4.08, 5.32 
2, -7, 666.8, 456.07, 1.01, 5, 6, 7, 8, 9 

 

We will create 20 Seven Segment components on the eLogger HMI screen to display the operating 

parameters, and another 20 Seven Segment components to display the parameters or to allow the user 

to input new values for the parameters. In addition, we will add three Switch components that can be 

used to re-load the parameters or to restore them from a file, as well as a Switch that can be used to 

display whether the data was successfully read or not. 

 

Components Quantity Settings 

Seven Segment 

(01-20) 
20 

Address: 101, 103, 105, ..., 139 

MouseContrl: FALSE (Read-only) 

Seven Segment 

(21-40) 
20 

Address: 201, 203, 205, ..., 239 

MouseContrl: TRUE (Read/write) 

Switch 3 Address: 1, 2, 3 

 
 

 3.4.1. The eLogger Developer Settings 
 

DO Tag: 

Add a new DO tag by expanding the “Tag Mapping” section in the navigation 

pane and then clicking the “DO Tag” item. In the “DO Tag” screen, click the 

“New Tag” button to add the new tag. Enter the name “Re_Load” and set the 

memory address to 1. For more information related to eLogger tags, refer to 

Section 2.3 "Declaring the eLogger Tag". 

 

Repeat this process to add the “Re_Store” tag and the “Read_Data_OK. 
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AO Tag: 

Expand the “Tag Mapping” section in the navigation pane and click the “AO Tag” item. In the “AO Tag” 

screen, click the “New Tag” button to open the “Add Tag” dialog box and add 20 new AO tags, as 

illustrated in the figure below. Refer to Section 2.3 "Declaring the eLogger Tag". 
 

Once the tags have been created, select the rows from Working_Val_0 to Working_Val_19, and set the 

1st Memory Address to “101”. The intermediate addresses will automatically add to the respective tags. 

Next, select the rows from Temp_Val_0 to Temp_Val_19, and set the 1st address to “201”. Again, the 

intermediate addresses will automatically add. 
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Page0: 

The upper 20 Seven Segment components on the eLogger HMI 

screen is to display the operating parameters. In this case, using 

the variable from Working_Val_0 to Working_Val_19.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Another 20 Seven Segment components is to display the 

parameters or to allow the user to input new values for the 

parameters. In this case, using the variable from Temp_Val_0 to 

Temp_Val_19.  

 

Configure these components as illustrated in the figure. 
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In addition, we will add three Switch components that can be used to re-load the parameters or to 

restore them from a file, as well as a Switch that can be used to display whether the data was 

successfully read or not. Configure these components as illustrated in the figure below. 
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 3.4.2. The ISaGRAF Settings 

Before we can begin creating our project, we must first declare the required project variables. See 

Section 1.2 Declaring the ISaGRAF Project Variables if you are not familiar. In this example, we will use 

the following ISaGRAF variables. 

 

Name Format Attributes 
Network 
Address 

Description 

TMP Boolean Internal 0  

RE_LOAD Boolean Internal 1 
Set this variable to TRUE to re-load a 
File 

RE_Store Boolean Internal 2 Set this variable to TRUE to store a File 

INIT Boolean Internal 0 Declare the initial value as TRUE 

Read_Data_OK Boolean Internal 3 True: data is ok, False: Data error 

Msg1 Message Internal 0 
This variable is used to set the 
maximum length of the message to 
128 characters 

str1 Message Internal 0 
This variable is used to set the 
maximum length of the string to 255 
characters 

TMP_file_name Message Internal 0 
This variable is used to set the 
maximum length of the temporary file 
name to 128 characters 

File1 Integer Internal 0 
This variable is used to temporarily 
save the status of the .txt file that the 
user created 

Working_ReaL_VAL[0..19] Real Internal 101 - 139 

This variable is used to define the 
operating parameters, and is an 
ISaGRAF variable array, where Dim = 
20. Declare the first Addr. value as 101 
(Hex=65) 

TMP_Real_VAL[0..19] Real Internal 201-239 

This variable is used to define an 
ISaGRAF variable array that is used to 
store the temporary values entered by 
the user, where Dim = 20. 
Declare the first Addr. value as 201 
(Hex=C9) 
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Name Format Attributes 
Network 
Address 

Description 

NUM1 Integer Internal 0 
This variable is used to temporarily 
save the REAL values 

ii Integer Internal 0 
This variable is used to set the Index 
value for the for-loop 

jj Integer Internal 0 
This variable is used to set the Index 
value for the for-loop 

Data_Cnt Integer Internal 0 
This variable is used to count the 
amount of data in the file 

Row_Cnt Integer Internal 0 
This variable is used to set the number 
of rows. Set the value to 2 in this case. 

Data_Cnt_in_Row Integer Internal 0 
This variable is used to set the amount 
of data that can be stored in each row. 
Set the value to 10 in this case. 

 
Project: 

The project contains three programs, the Load1 program is used to read data from a file, the Save1 

program is used save data to a file, and the other1 program is used to do the user-defined commands 

when the Read_Data_ok variable is set to TRUE. 

 
 
 
 
 
 
 
 
 
Program - Load1: 

The Load1 program is to read data from a file. 
 
 (* Operations in the first PLC Scan *) 

 if  INIT  then 

   (* Assign a Network address for the Array Variable *) 

   (* Assign the Working_Real_VAL[ ] as 101 , 103, 105, ..., 139 *) 

   TMP := S_MB_ADR( 101 , 20 , 1 ) ;     
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 (* Assign the TMP_Real_VAL[ ] as 201 , 203, 205, ..., 239 *) 

   TMP := S_MB_ADR( 201 , 20 , 1 ) ;   

   (* Assign the name of the file which stores the current working parameters *) 

   TMP_file_name := '\System_Disk\Working_Real.txt'  ;    

   RE_LOAD := True ;   (* A trigger to read data from the file when the PLC is started *) 

 end_if ; 

 
 (* If RE_LOAD is TRUE, open a file and read it *) 

 if  RE_LOAD  then 

   RE_LOAD  :=  FALSE  ;  (* Reset the status of the RE_LOAD variable to FALSE *) 

   Read_Data_ok := False ;   (* Initialize the data error flag as FALSE *) 

   Data_Cnt := 0 ;          (* Initialize the data count to indicate that no data has been read *) 
 

   File1 := f_wopen( TMP_file_name )  ;   (* Try opening the file in Read & Write mode *) 
 

   if  File1 = 0 then    

    (* If there is an error opening the file, exit this ST program to run the next program *) 

Msg1  :=  'Cannot Open file ' + TMP_file_name ;  

     INIT := False ;  (* Reset the initialization before exiting the ST program *) 

     return ; 

   end_if  ; 

 

   (* To read data. In this case, there are two rows of data and each row contains 10 REAL values, 

totally 20 REAL values in the file. *) 

   for  ii  :=  0  to  ( Row_Cnt - 1 )  do 

      if  f_eof(File1) = TRUE  then   (* Test if the end of the file has been reached *) 

      (* The end of the file has been reached *) 

      Msg1 := 'There should be at least ' + MSG(Row_Cnt)+ ' rows in the ' +TMP_file_name+ ' file.' 

; 

exit ;            (* Exit the FOR loop *) 

      end_if ; 

 

   str1 := fm_read(File1) ;   (* Read one row as a String (Message) *) 
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(* Convert this string to some REAL values and store them in Float array No. 1 *) 

   NUM1 := Msg_F( str1 , 1 );   

   if  NUM1 <> Data_Cnt_in_Row  then  (* There should be 10 REAL values in each row *) 

 (* If there is an error, it means the data is not a REAL value or the amount of data is incorrect *) 

      Msg1  :=  'The data format of row No.' + Msg( ii + 1 ) + ' is not correct or the amount of 

data is not ' + MSG( Data_Cnt_in_Row ) ; 

      exit ;               (* Exit the FOR loop *) 

   end_if; 

 

     Data_Cnt := Data_Cnt + Data_Cnt_in_Row;  (* OK ! Data_Cnt plus Data_Cnt_in_Row *) 

     (* The conversion was successful, and these 10 REAL values have been stored in 

TMP_Real_VAL[ ] *) 

     for jj := 0 to ( Data_Cnt_in_Row - 1 ) do 

        (* Retrieve the converted REAL values from address 1 to 10 in Float array No. 1 *) 

        TMP_ReaL_VAL[ Data_Cnt_in_Row * ii + jj ] := ARY_F_R( 1 , jj + 1 ) ;    

     end_for ; 

 end_for ;   

 

   TMP := f_close(File1) ;   (* Any file that is open should be closed using f_close( ) *) 

 

   (* All data has been read successfully *) 

   if  ( Data_Cnt = Row_Cnt * Data_Cnt_in_Row )  then 

     Msg1 := 'Read ' + TMP_file_name + ' Ok ' ; 

     Read_Data_Ok := True ;  (* Set the data read flag to TRUE *) 

(* If this is the first scan, store the TMP_Real_Val[] information in the respective 

Working_ReaL_Val[] array element *) 

  if  INIT  then 

    for  ii := 0  to  ( Data_Cnt - 1 )  do 

         Working_ReaL_VAL[ii] := TMP_ReaL_VAL[ii] ; 

end_for ; 

   end_if ; 

end_if ; 

end_if ; 

 INIT := False ;  (* Set the initialization to FALSE to indicate that this is not the first PLC scan *) 
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Program - Save1:  

The Save1 program is to save data into a file. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 (* Save the data in a file when the RE_Store variable is TRUE *) 

 (* This "RE_Store" variable can be triggered via the eLogger HMI *) 

 if  RE_Store  then 

   RE_Store := False ;       (* Reset the status of the RE_Store variable to FALSE *) 

   Read_Data_ok := False ;  (* Initialize the data error flag as FALSE  *) 

   Data_Cnt := 0 ;          (* Initialize the data count to indicate that no data has been read *) 

 

(* Delete file first and then create a new file and write to it *) 

   TMP := f_delete( TMP_file_name )  ;   

(* Create a new file *) 

   File1 := f_creat( TMP_file_name ) ; 

 

   (* File creation failed, exit the ST program *) 

   if  File1 = 0  then 

     MSG1 := 'Cannot create a new file - ' + TMP_file_name + ' !' ; 

     return ;     (* Exit the ST program *) 

   end_if ; 

 

(* To save data. In this case, there are two rows of data and each row contains 10 REAL values, 

totally 20 REAL values in the file. *) 

  for  ii  :=  0  to  ( Row_Cnt - 1 )  do      

     str1 := '' ;   (* Set as an empty string at the beginning *)   

 

(* There are 10 data records in a single row *) 

     for  jj := 0  to  ( Data_Cnt_in_Row - 2 )  do  

       str1 := str1 + Real_Str( TMP_ReaL_VAL[Data_Cnt_in_Row * ii + jj] ) + ', ' ; 

     end_for ; 

 
   (* Add the last data record from this row to the str1 variable *) 

     str1 := str1 + Real_Str( TMP_ReaL_VAL[Data_Cnt_in_Row * ii + jj] ) + '$0D$0A' ; 
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Program - Other1: 

The Other1 program is to do the user-defined commands when the Read_Data_ok variable is set to TRUE. 
 
(* If the Read_Data_OK variable is set to False, which means the process parameters of the 
Working_ReaL_VAL[ ] is not ready. Then return. *) 

 
(* If the Read_Data_OK variable is set to True, then you can use the parameters of the 
Working_ReaL_VAL[ ] in the user-definded logic below. *) 

 

     (* Write this row to the file *) 

     TMP := F_writ_S( File1 , str1 ) ; 

     if  TMP = False  then 

        MSG1 := 'Write data to file - ' + TMP_file_name + ' failed !' ; 

        exit ;   (* Exit this FOR loop *) 

     end_if ; 

 
     Data_Cnt := Data_Cnt + Data_Cnt_in_Row;  (* Success! Data_Cnt plus Data_Cnt_in_Row *) 

  end_for ; 

 
  TMP := f_close(File1) ;     (* Any file that is open should be closed using f_close() *)  

  (* All data has been saved successfully *) 

  if  ( Data_Cnt = Row_Cnt * Data_Cnt_in_Row )  then 

     Msg1 := 'Write ' + TMP_file_name + ' Ok ' ; 

     Read_Data_ok := True ;  (* Set the data read flag to TRUE *) 

     (* Store the TMP_Real_Val[] record in the respective Working_ReaL_Val[] array element *) 

     for  ii := 0  to  ( Data_Cnt - 1 )  do 

       Working_ReaL_VAL[ii] := TMP_ReaL_VAL[ii] ; 

     end_for ; 

  end_if ; 

end_if ; 
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 3.4.3. Testing the “eL_03” Project 
 

 Copy the Working_Real.txt file to the \System_Disk folder via FTP and reboot the PAC. Make sure this 

file save using ANSI encoding. The file name must be the same as that declared in the program. 

Note:  If the file is not coping to the \System_Disk folder, the button text “Data Error” will display on 

the right of the eLogger HMI without any data.  

 Upload the ISaGRAF project to the PAC first, and then upload the eLogger project. 

 The values for “New Val” can change in the eLogger HMI.  

For example, in the diagram below, click the value you want to change in the “New Val” section to 

open the “Value Entry” dialog box. Enter the new value and click the “OK” button to save the new 

value. Repeat this process for each item that you want to change, and then click the “Apply New Val” 

button to update these values in the “Working Val” area. If the PC/ISaGRAF connect to the PAC, you 

can also check to see if the variable values have changed.  

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The new value will be written to 

the file after clicking “Apply 

New Val” button. 
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 3.5. Reading/Saving Process Parameters from/to a File (Data Format: Integer)  
 

In this example, we will use the following project files: 

 

The ISaGRAF Project File:  eL_04. pia   

The eLogger Project File:  eL_04.wez 
 

This project is similar to the previous “eL_03” project (See Section 3.4 “Reading/Saving the Process 

Parameters from/to a File”), but this time the data format is Integer. First, create a txt file called 

Working_Int.txt that includes two rows of data, with each row containing ten Integer values. Ensure this 

file is saved using ANSI encoding. Copy the Working_Int.txt file to the \System_Disk folder via FTP. Open 

the ISaGRAF and the eLogger project for more details and then upload projects to the PAC. 

 
Testing the “eL_04” Project: 

The values “New Val” can change in the eLogger HMI. For example, in the diagram below, click the value 

you want to change in the “New Val” section to open the “Value Entry” dialog box. Enter the new value 

and click the “OK” button to save the new value. Repeat this process for each item that you want to 

change, and then click the “Apply New Val” button to update these values in the “Working Val” area. 

If the PC/ISaGRAF is connected to the PAC (See Section 1.7) , you can also online check to see if the 

related variable values are changed.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Read all values in the file 
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 3.6. Reading/Saving Process Parameters from/to Different Files (Data Format: REAL) 
 

In this example, we will use the following project files: 

 

The ISaGRAF Project File:  eL_05. pia   

The eLogger Project File:  eL_05.wez 
 

This project is similar to the previous “eL_03” project (See Section 3.4 “Reading/Saving the Process 

Parameters from/to a File”) and the data format is REAL. However, multiple values can save into 

different files. First, create a txt file called Working_Reals.txt that includes two rows of data, with each 

row containing ten REAL values. Ensure the file save using ANSI encoding. Copy this file to the 

\System_Disk folder via FTP. Open the ISaGRAF and the eLogger project for more details and then 

upload projects to the PAC.  
 

Note: The file name and the storage path must be the same as that declared in the program. The data 

contained in the txt file can be the same as that used for the “eL_03” demo. 

 
Testing the “eL_05” Project: 

Create a connection between the PC/ISaGRAF and the PAC (See Section 1.7 if not familiar), and view the 

list of variables as illustrated in the figure below. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The file used to read/write data. 

A maximum of 100 
files can be set. 
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First, all the values that are stored in the Working_Reals.txt file in the \System_Disk folder will display 

on the eLogger HMI screen. Change the “Which_File” value (where n can be in the range of 1 to 100) to 

write data to the specified “Backup_Reals_n.txt” file. Note the txt file will automatically create if it does 

not exist.  

 
Test: 

 In the diagram below, click the value that you want to change in the “New Val” section to open the 

“Value Entry” dialog box. Enter the new value and click the “OK” button to save the new value. Set 

the “Which_File” value to “2”, and then click the “Apply New Val” button to write the data to the 

“Backup_reals_2.txt” file and the “Working_Reals.txt” file in the \System_Disk folder. In addition, the 

values shown in the “Working Val” area will be updated using those entered in the “New Val” area 
 

 In this case, if you click the “Store_No_Apply” button, it means that the values shown in the “New 

Val” area written to the “Backup_reals_2.txt” file, but the value displayed in the “Working Val” area 

will not update and will not save into the “Working_Reals.txt” file.  
 

 If you click the “Re_Load” button, it means 

that all the values that are stored in the 

“Backup_reals_2.txt” file will display in the 

“New Val” area. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

After creating a connection between 

the PC/ISaGRAF and the PAC, this list 

of variables will display.  
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 3.7. Reading or Modifying the Date and Time on the PAC for the Time Control 
 

In this example, we will use the following project files: 

 

The ISaGRAF Project File:  eL_06. pia   

The eLogger Project File:  eL_06.wez 
 

The project used in this example shows how to display or change the date and time on the PAC. In this 

example, we set the OUT1 variable to ON from 09:00 to 18:00 on Monday to Friday, and set the OUT2 

variable to ON from 09:00 to 12:00 on Saturday and Sunday. 

 
 

 3.7.1. The eLogger Developer Settings 

In this example, we will use the following eLogger tags. 

 
AO Tag: Configuring the AO tags as illustrated in the figure beolw. See Section 2.3 if not familiar. 
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DO Tag: Configure the DO tags as illustrated in the figure below. See Section 2.3 if not familiar. 
 
 
 
 
 
 
 
 
 
 
 
Page0: 
Configuring the following components as illustrated in the figure below. See Section 2.4 if not familiar. 
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 3.7.2. The ISaGRAF Settings 

Before we can begin creating our project, we must first declare the required project variables. See 

Section 1.2 Declaring the ISaGRAF Project Variables if you are not familiar. In this example, we will use 

the following ISaGRAF variables. 

 

Name Format Attributes 
Network 
Address 

Description 

Set_Time Boolean Internal 101 
Set this variable to True to allow the date 
and time to be changed 

Refresh_Time Boolean Internal 102 
This variable is used to refresh the current 
date and time 

OUT1 Boolean Internal 0 
This variable is a link to the DO0 channel 
on the XW304 

OUT2 Boolean Internal 0 
This variable is a link to the DO1 channel 
on the XW304 

Time_Val Integer Internal 0 

This variable is used to set a time period 
(unit: minutes, the value 0 to 1439 means 
00:00 to 23:59) 
Set the Initial value to 0 

Year1 Integer Internal 1 

These variables are to retrieve the current 

date and time on the PAC.  

 

E.g., Year, Month, Day, Hours, Minutes, 

Seconds, and Weekday. 

Month1 Integer Internal 2 

Day1 Integer Internal 3 

Hour1 Integer Internal 4 

Minute1 Integer Internal 5 

Second1 Integer Internal 6 

WeekDay1 Integer Internal 0 

W_Year1 Integer Internal 11 

These variables are to set the new date 

and time on the PAC.  

 

E.g., Year, Month, Day, Hours, Minutes, 
and Seconds. 

W_Month1 Integer Internal 12 

W_Day1 Integer Internal 13 

W_Hour1 Integer Internal 14 

W_Minute1 Integer Internal 15 

W_Second1 Integer Internal 16 
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I/O Connection: 

Configuring the xw304 board in the I/O connection dialog box as illustrated in the figure below. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Program - LD1: 

The LD1 program is to  

read/write the system date 

and time on the PAC. 
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Program - ST1: 

In this program, we set the OUT1 variable to ON from 09:00 to 18:00 on Monday to Friday, and set the 

OUT2 variable to ON from 09:00 to 12:00 on Saturday and Sunday. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(* Units are seconds, 0 ~ 86399  

   Time_val:= 3600 * Hour1 + 60* Minute1 + Second1;  *) 

  

 (* Units are minutes, 0 ~ 1439 *) 

 Time_Val:= 60 * Hour1 + Minute1; 

 

 OUT1:= False;   (* Initially set to False *) 

 OUT2:= False; 

 

 (* Set OUT1 to True for 9:00 to 18:00 on Monday to Friday *) 

 if (WeekDay1 >= 1) and (WeekDay1 < 6) and 

    (Time_Val >= 540) and (Time_Val < 1080) then 

   OUT1:= True; 

 end_if; 

 

 (* Set OUT2 to True for 9:00 to 12:00 on Saturday and Sunday *) 

 if (WeekDay1=6) and (WeekDay1=7) and 

    (Time_Val >= 540) and (Time_Val < 720) then 

   OUT2:= True; 

 end_if; 

 

 (* Refresh to the current date and time *) 

 if  Refresh_Time  then 

   Refresh_Time:= False;  (* Reset to False *) 

   W_Year1:= Year1; 

   W_Month1:= Month1; 

   W_Day1:= Day1; 

   W_Hour1:= Hour1; 

   W_Minute1:= Minute1; 

   W_Second1:= Second1; 

 end_if; 
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 3.7.3. Testing the “eL_06” Project 

Click the “Update the Current Date/Time” button to set the current date and time of the PAC in the  

"Set New” section. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

To adjust the date and time, click each component and enter a new value for the item. For example, in 

the diagram below, click the second’s component in the “Set New” section to open the “Value Entry” 

dialog box. Enter the new value and click the “OK” button to save the new value. Repeat this process 

each item that needs to adjust, and then click the “Set as New Date/Time” button and click the “OK” 

button to change the information displayed in the “Current” date and time section above. 

 
 
 
 
 

1. 
2. 

3. 

1. 

2. 


